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This user guide is about Money Manager Ex (Version 1.3.5), and is intended for users to 
leverage the features of the application.

If you are using a different operating system, browser, device, or have configured your

operating system differently than we have, some procedures, settings, or images that

are shown in this text may differ from what you see on your screen. These differences 
should be very minor and should not affect your actions within the application.

Money Manager Ex© is designed for the benefits of the public, which is why we remain 
an open-source and unlicensed software for everyone to use. The application is com-
pletely free and available to anyone with access to a computer and the Internet. Users 
are permitted to copy and distribute verbatim copies of this license document but are 
not allowed to change it. 

Everyone should have an easy and reliable tool for managing personal finance, so we 
developed one for you. With Money Manager Ex©, you can easily track where, when, 
and how your money flows and build healthier personal financial habits.

Preface
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Chapter 1: Getting Started

What is Money Manager Ex?
Money Manager Ex (hereinafter referred to as MMEX) is a free and open source soft-
ware designed for language learning. It serves as a simple and user-friendly tool for you 
to control and monitor your personal finances. It was developed to address your need 
for a tool to maintain good financial records and make informed decisions.

MMEX allows you to track activities in multiple accounts and different currencies at the 
same time. Its purpose is to help you build better personal financial habits. It was creat-
ed with the vision that you would use the software everyday to keep comprehensive re-
cords of your income, expenses, assets, and make informed decisions on investments 
and budget accordingly. 

MMEX allows you to easily import and export data from any CSV and QIF formats. With 
its unique built-in report generator, you can quickly and easily create comprehensive 
charts, graphs, and reports. You can also schedule transactions and set reminders for 
recurring bills and paychecks. With everything stored in a Non-Proprietary SQLite Data-
base with AES Encryption, you can be reassured that your financial information is safe 
and secure with MMEX.

With a diverse and global team, we have contributors providing user support from all 
around the world. As of December 2020, we have international language support avail-
able in 24 languages. 

The Home Interface
The Home Interface shows you your list of accounts and a brief overview of your finan-
cial activities. This interface is blank by default when you first create a database. You 
can view and access your financial information here after adding new accounts and 
information on financial activities like transactions.

The MMEX interface has the following components: 
•	 The Navigation pane on the left shows a hierarchical structure of all the inter-

faces and related sections, such as accounts, assets, and recurring transactions. 
See navigation pane for more.
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•	 The Top Menu bar contains various menu items for easy shortcut actions in the 
software. See Top menu bar for more.

•	 The Workspace area displays information about the section you are working 
with. For example, your cash account and related transactions. 

The Top Menu bar 
The Top Menu bar contains various menu items for easy shortcut actions in the soft-
ware.	

Item Icon Function
New Database Create a new database

Open Database Open an existing database 

New Account Create a new acount 

Account List Return to the Home interface and show the account 
list

Show Organize Catego-
ries Dialog Display Organize Categories Dialog

Show Organize Payees 
Categories Dialog Display Organize Payees Categories Dialog

Show Organize Currency 
Dialog Display the Organize Currency Dialog

Transaction Report Filter Filter transactions for review 

General Report Manager Display the General Report Manager Help page 

Options Dialog Display the Options dialog 

New Transaction Create a new transaction

Register/View Release 
Notifications Display release notificaitons in a brower

Download Currency and 
Stock Rates

Download currency and stock rates from your de-
fined sotck quote web page

Toggle Fullscreen Toggle fullscreen 
Table 1-1 Items and functions in the Top Menu bar



3

Money Manager Ex User Guide

Item Icon Function

Print current view Print the current workspace view

Show about dialog Display the About dialog 

Show the Help Page Display the Money Mager Ex User Manual

Settings and Preferences 
The overall look-and-feel of the application can be configured and may not appear as seen in 
this documentation depending on your setup, but general functionality remains the same. Use 
the Options dialog (Tools > Options) to change settings. These are the available setting 
categories:

•	 General: This category contains configuration options for display heading, base 
currency, date format, financial year, and transaction sound and dates.

•	 View Options: This category contains configuration options for display like icon 
size, visible accounts, and HTML scale factor.

•	 Attachments: This category contains configuration options for attachments. This 
category is only applicable for Windows users.

•	 Network: This category contains configuration options for the MMEX WebApp.
•	 Others: This category contains configuration options for the stock quote web 

page, New Transaction dialog settings, database backup, and CSV settings.

The General category
This section explains the settings in the General category.

Item Function
Display Heading configure the displayed user name 
Currency set the base currency 
Date Format set the displayed date format 
financial year set when a fiancial year begins 
Use Original Date when Pasting Trans-
action

check to use original date when co-
py-and-pasting transactions

Use Transaction Sound check to play the sound effect for transac-
tions

Table 1-1 Items and functions in the Top Menu bar

Table 1-2Items and functions in the General category
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The View Options category
This section explains the settings in the View Options category.

Item Function
View Options •	 filter accounts visible 

•	 set the HTML scale factor 
•	 set the icons size 

View Budgets as Financial Years check to view your budget as financial 
years

View Budgets with “transfer” transactions check to view your budgets with transac-
tions displated

View Budget Category Report with Sum-
maries

check to view bedget catefory report with 
summaries 

Ignore Future Transactions check to not display future transactions 
User Colors set the colour schemes used in the soft-

ware
Table 1-3 Items and functions in the View Options category

The Attachments category
This section explains the settings in the Attachments category.

Item Function
Attachment Settings •	 only available for Windows 

•	 set the default attachment archive folder  
Create and use Attachments subfolder check to create the use an attachment sub-

folder for each database 
Delete file after import check to delete the original file after importing 

into MMEX
When remove attachment, move the 
file instead of delete

check to move the file to the attachment ar-
chive folder when removing it

Table 1-4 Items and functions in the Attachments category

The Network category
This section explains the settings in the Network category.

Item Function
WebApp Settings •	 set the folder Url for remote upload

•	 set the GUID for data sync with desktop 
version

Table 1-5 Items and functions in the Network category
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Item Function
Proxy Settings set the Proxy and number of ports 
Usage statistics check to send the anonymous usage data 
Timeout set the duration before timeout is activated 
Updates check to check for updates at StartUp

Table 1-5 Items and functions in the Network category

The Others category
This section explains the settings in the Others category.

Item Function
Stock Quote Web Page •	 set the URL for the stock quote web page 

•	 the default link is http://finance.yahoo.
com/echarts?s=%s

New Transaction Dialog Settings •	 set the default date 
•	 set the default payee 
•	 set the default category
•	 set the default status 

Database Backup •	 check to create a new backup when you 
launch MMEX

•	 check to backup database on exit 
•	 set the maximum number of backup files 

CSV Settings set the symbol as the delimiter 
Table 1-6 Items and functions in the Others category

Configuring the settings 
Refer to tables 1-2, 1-3 1-4, 1-5 and 1-6 for the properties you can configure for MMEX. 
To configure the settings 

1.	 Select a category you wish to configure.
2.	 Select a property you wish to configure.
3.	 Configure the setting as required.
4.	 Select Apply to apply changes to the category and continue configuring the set-

tings. 
Or  
Select Ok to apply changes and close the Options dialog. 

Initializing your database 
This section helps you get started with MMEX by creating a database. To learn more 
about databases, see “About Database” on page 21. Your MMEX is empty by default 
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when you first install the software, and you are prompted to create a new database 
when you initially launch it. To start using MMEX, you can create a new database. You 
can maintain multiple MMEX databases on the same computer at the same time. You 
can select where on your machine you want to store the databases. 

Creating a new database 
You can create a new database to start using MMEX. 
To create a new database 

1.	 Select New Database from the Top Menu bar.
2.	 Navigate to a desired location on your computer.
3.	 Enter a file name and select Save.

About accounts 
This section helps you manage your MMEX accounts. You can create multiple accounts 
and with different currencies within a single database. Your database is empty by default 
when you initially create it. To start managing your personal finance, you can create a 
new account. 

Account Types 
There are eight types of accounts you can create in MMEX, and the Add Account Wiz-
ard makes it easier to do so. These are the types of accounts MMEX supports: 

•	 cash
•	 checking 
•	 credit card 
•	 loan
•	 term 
•	 investment 
•	 asset
•	 shares 

Creating a new account
You can create a new account with the Add Account Wizard. 
To create a new account 

1.	 Select New Account from the Top Menu bar.  
The Add Account Wizard displays. 

2.	 Read the texts and select Next.
3.	 From the drop-down menu, select the type of account you wish to create and 
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select Next.
4.	 Enter a name for the account and select Finish.

Note: In the process of creating a new account, you must first enter an account 	
name if you wish to return to the previous page to change the account type. 

	 The Edit Account dialog displays.

5.	 Configure the settings as required.
6.	 Select OK to create the account.
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About Transactions 
Transactions in MMEX refers to the exchange of monetary value from one account (or 
party) to another. MMEX supports different types of transactions and allows you to set 
them to certain statuses. You can also choose from an extensive list of categories or 
customize your own. This section guides you to manage your transactions and payees. 

Transaction types
MMEX organize transactions by bank accounts, and you can assign a type to each 
transaction.
A transaction type informs the user whether it is a withdrawal, deposit, or transfer. 

•	 A withdrawal transaction refers to the act of converting and removing an amount 
of funds from a bank account, savings plan, bank account, or pension into cash. 
In MMEX, any expense and payment to another party is considered a withdrawal.

•	 A deposit transaction refers to the act of placing a sum of money into a bank 
account. In MMEX, any money you receive from another party is considered a 
deposit.

•	 A transfer transaction refers to the act of transferring a sum of money from a 
bank account to another account. In MMEX, any money that is withdrew from one 
account and deposited to another is considered a transfer. These transactions 
are not included in the MMEX Income/Expense calculations. 

Transaction Statuses 
MMEX organize transactions by bank accounts, and you can assign a status to each 
transaction.

A transaction status informs the user where a transaction is in the transaction process. 
These are the five status options: 

•	 None: This is the default status. Choosing this leaves the status information for 
the transaction as blank.

•	 Reconciled: A transaction can be marked with a “Reconciled” status when the 
transaction is checked and verified with your card company’s balance informa-
tion. 

Chapter 2: Transactions 
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•	 Void: A transaction can be marked with a “Void” status if the transaction is invalid 
or cancelled. Void transactions are archived and are not included in the MMEX 
Income/Expense calculations. 

•	 Follow up: A transaction can be marked with a “Follow up” status if it needs more 
actions. It acts as a reminder for you to follow up with your financial institutions or 
edit the transaction as required.

•	 Duplicate: A transaction is automatically marked with a “Duplicate” status when 
MMEX recognizes it as one. 

Managing transactions 
MMEX makes tracking incomes and expenses easier for you by allowing you to cus-
tomize the displayed information for each transaction. You can add, edit, and schedule 
recurring transactions 

The New Transaction dialog
The New Transaction dialog allows you to create and configure your new transaction.
Item Function
Date •	 Set the date of the transaction

•	 Default: the current date 
Status •	 Assign a status to the transaction 

•	 Default: “None”
•	 See “transaction statues”

Type •	 Assign a type to the transaction 
•	 See “transaction types”

Amount •	 Enter the amount for the transaction in 
the first input box. 

•	 The second input box is only activated 
for Transfer transactions. 

Account/From •	 This item appears differently for differ-
ent transaction types. 

•	 Withdrawal/Deposit: “Account”; select 
an account to withdraw from or depos-
it to 

•	 Transfer: “From”; select an account to 
transfer the money from 

Table 2-1 Items and functions in the New Transaction dialog.
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Item Function
Payee/From/To •	 This item appears differently for differ-

ent transaction types. 
•	 Withdrawal: “Payee”; select who the 

payee is 
•	 Deposit: “From”; select who the de-

posit is from  
•	 Transfer: “To”; select an account to 

transfer the money to
Split •	 Check to record multiple categories 

for a single transaction. 
•	 This checkbox activates the Split 

Transaction dialog. 
•	 This checkbox is only available for 

Withdrawal and Deposit transactions.
Category •	 Select a category for your transaction.

•	 You can customize categories.
Number •	 Enter a number associated with the 

transaction number (i.e. transaction 
number or cheque number)

•	 Optional
Note •	 Enter any additional notes regarding 

the transaction. 
•	 Optional

Adding a transaction
You can add and define a transaction with the New Transaction dialog. See table 2-1 for 
the mandatory and optional fields. 
To add a transaction 

1.	 From the Top Menu bar, select New Transaction. 
The New Transaction dialog displays. 

2.	 In the New Transaction dialog, fill in the mandatory input fields. 
3.	 Optional: Fill in the optional input fields. 
4.	 Select OK.

Table 2-1 Items and functions in the New Transaction dialog.
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Editing a transaction
Transactions are organized by their associated bank accounts. You can edit transac-
tions in the Account view. 
To edit a transaction

1.	 From the Navigation pane, select an account to navigate to the Account View.
2.	 Select the View All Transactions button to filter the transactions by dates. 
3.	 Select a transaction and select Edit.  

The Edit Transaction dialog displays.
4.	 Edit as needed. 
5.	 Select OK. 

Managing Recurring Transactions 
Recurring transactions in MMEX refers to any transactions you enter to the database 
to be processed at a future date. These transactions are displayed under Upcoming 
Transactions on the Home interface, within 15 days of the scheduled due date. They 
can be set up to be automatically or manually activated. If you set it up to be manually 
activated, MMEX would ask you to adjust the settings on the scheduled due date. 

Adding a recurring transaction 
You can add a recurring transaction in the Recurring Transactions view.
To add a recurring transaction

1.	 From the Navigation pane, select Recurring Transactions to navigate to the 
Recurring Transactions View.

2.	 Select New. 
The Recurring Transaction dialog displays. 

3.	 Specify a due date for the transaction.
4.	 From the Repeat drop-down menu, select how often you want the transaction to 

recur. 
5.	 Enter transaction details as needed. 
6.	 Select Enter.

Editing a recurring transaction 
You can edit an existing recurring transaction in the Recurring Transactions View.
To edit a recurring transaction 

1.	 In the Recurring Transactions View, select a transaction. 
2.	 Select Edit.  

The Edit Recurring Transaction dialog displays. 
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3.	 Edit as needed. 
4.	 Select OK.

Skipping a recurring transaction
You can skip the next transaction occurrence for your transactions in the Recurring 
Transactions View.
To skip a recurring transaction

1.	 In the Recurring Transactions View, select a transaction. 
2.	 Select Skip.  

The next transaction occurrence for the selected transaction is now skipped. 
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About stocks and shares 
You can easily track your investment in stocks and shares with MMEX. MMEX automati-
cally adds your Stocks to your total financial worth. 

The terms “stocks” and “shares” are often used interchangeably, and they generally 
have the same meaning, but their meaning could also change depending on the context 
they are used in. 

Investment professionals use “stocks” to refer to publicly traded companies. The major-
ity of issued stocks are “Common Stocks”, which is the type of stock that most people 
invest in and represents shares of ownership in the corporation. 

Shares, on the other hand, refers to a single smallest denomination (unit of value) of a 
corporation’s stock. The two main types of shares are “Common Shares” and “Preferred 
Shares”, and they carry different rights and privileges. For more information, read this 
article on the differences between stocks and shares. 

Note: You need a stockbroker to obtain stocks and purchase and sell shares. 
MMEX is only a tracking tool. 

Managing Stocks and Shares 
To manage your investments in stocks and shares with MMEX, you must first create a 
stock portfolio. Any transactions relating to your stocks and shares can be managed in 
the Stock Portfolio view; and any transactions involving your personal accounts can be 
managed in the Account view.

Creating a Stock Portfolio
You must create an investment account and stock portfolio before adding any informa-
tion on stocks and shares. In MMEX, an investment account and stock portfolio repre-
sent the same thing.
To create a stock portfolio

1.	 From the top menu bar, select New Account. 
The New Account dialog displays.

Chapter 3: Investments 

https://www.investopedia.com/ask/answers/difference-between-shares-and-stocks/
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2.	 Enter a name for the account and select Next.

Tip: We suggest you use the name of your stockbroker. For example, “Yahoo! 
Finance”.  

3.	 Select Finish.  
The Edit Account dialog displays.

4.	 Edit the values in the input fields and select OK. 
The new account now displays under Stock Portfolios in the Navigation Pane.

The New Stock Investment dialog

The New Stock Investment dialog allows you to create and configure your new transac-
tion stock investment.

Item Function
Company Name set the company name for this stock in-

vestment
Stock Symbol optional: add a symbol for your stock in-

vestment (i.e. IBM)
Date •	 specify the date you made the stock 

investment 
•	 only for the initial share transaction

Share Number •	 specify the number of shares 
•	 only for the initial share transaction

Share Price •	 specify the initial price per share 
•	 only for the initial share transaction

Commission •	 specify any commission paid
•	 only for the initial share transaction

Curr. Share Price specify the current share price 
Notes optional: add extra notes about the invest-

ment
Stock History Options •	 shows you the stock price history

•	 this is blank by default
Table 3-1 Items and functions in the New Stock Investment dialog.

Creating your initial stocks and shares investment 

In MMEX, a Stock Investment refers to a company you have purchased shares from. To 
initialize your stock portfolio, you must add your first stock investment. 

1.	 From the Navigation Pane, select a stock portfolio to add the new investment to. 
2.	 In the Stock Portfolio view, select New. 
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The Edit Stock Investment dialog appears. 

Note: Items with an * next to them are required only for the initial share transac-
tion. 

3.	 Edit the values in the input fields and select Save. 
A new share price now populates the Stock History Options column.

4.	 Select Add. 
An error message displays because there are no existing Share Accounts. 

5.	 Select OK to create a Share Account. 
The Add Share Transaction dialog displays.

6.	 Under Add Transaction Details, specify the account, type, and category for the 
Share transaction and select OK. 
Your first stocks and shares investment now display in your Stock Portfolio.

Creating a share purchase 
In MMEX, a share purchase is a Withdrawal transaction from your stock portfolio. You 
can create a share purchase in the Stock Portfolio view.

1.	 In the Navigation Pane, select a stock portfolio. 
2.	 In the Stock Portfolio view, select Add Trans.  

The Add Share Transaction dialog displays. 
3.	 Specify the transaction type as Withdrawal.
4.	 Add investment and transaction details and select OK.
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Creating a share sale 
In MMEX, a share sale is a Deposit transaction from your stock portfolio. You can create 
a share sale in the Stock Portfolio view.

1.	 In the Navigation Pane, select a stock portfolio. 
2.	 In the Stock Portfolio view, select Add Trans.  

The Add Share Transaction dialog displays. 
3.	 Specify the transaction type as Deposit.
4.	 Add investment and transaction details and select OK.

Viewing stock transactions 
You can easily view a list of your share transactions for a stock portfolio after adding 
them into your account.

1.	 In the Navigation Pane, select a stock portfolio. 
2.	 In the Stock Portfolio view, select View Trans.  

The View Stock Transactions dialog displays. 
3.	 Review the list and select OK to close.
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About Assets
An asset is something of value that can be converted into cash. With MMEX, you can 
track the values of your personal assets and even calculate your financial worth. MMEX 
estimates your financial worth by subtracting your liabilities (things you owe) from your 
assets (things you own). To know more about assets, read this article on what an asset 
is.

MMEX supports the creation of seven types of assets. These assets are:
•	 property 
•	 automobile
•	 household object 
•	 art
•	 jewelry 
•	 cash 
•	 other

You can track the value of your assets by specifying their current value and make 
changes to them in the future. There are two kinds of value changes: Appreciates and 
Depreciates. Appreciates refer to the increase in the value of an asset over time, and 
depreciates refer to the decrease in the value of an asset over time. 

Creating a new asset 
You can create a new asset in the Assets view.

Note: When you create your first asset, MMEX automatically creates a new As-
sets account for you.

To create a new asset
1.	 From the Navigation pane, select Assets to navigate to the Assets view. 
2.	 In the Assets view, select New.  

The New Asset dialog displays.
3.	 Fill in the input fields as required. 

Chapter 4: Assets and Budgeting
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4.	 Select OK.

About Budgeting 
A budget is a financial plan you create for a define period. MMEX supports the creation 
of monthly and yearly budgets. We recommend that you create budgets so you can 
compare the money you spent against your initial plans and form healthier and informed 
financial decisions. In MMEX, you can configure the display settings to show budgets in 
calendar or financial years.  

Configuring the start of a financial year 
You can set the start date of a financial year according to your preferences using the 
Options dialog.
To configure the starts of a financial year 

1.	 From the Top Menu bar, select Options.
2.	 From the Options dialog, navigate to the General section. 
3.	 Under Financial Year, enter a Start Day and specify the Start Month as re-

quired. 
4.	 Select OK to close and save your configurations.

Creating a new budget 
You can create a new budget with the Budget Setup item in the Navigation Pane. The 
new budget will be empty by default. 
To create a new budget

1.	 From the Navigation Pane, right-click on Budget Setup to open the Budget 
Editor.

2.	 Select Add Year or Add Month and select OK.  
The Budget Entry Details dialog displays.

3.	 Specify the budget year and/or month as required.
4.	 Select OK. 

Your new budget now displays in the Budget Editor.

Editing a budget 
Start editing your budget with the Budget Setup view. 
To edit a budget

1.	 In the Navigation Pane, under Budget Setup, select a budget year and/or 
month.  
The Budget Setup view displays. 
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2.	 Double-click a category. 
A Budget Entry Details dialog displays. 

3.	 Fill in the input fields as required.
4.	 Select OK.

Note: The exclamation mark icon  indicates that there are existing expense or 
income transactions, and you should create a budget for it. After creating a bud-
get for the item, the exclamation mark will be replaced by a check mark icon .  
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Chapter 5: Database and Reports

About Database  
To start using MMEX, one option is to import data from another file to avoid duplicated 
efforts when creating a new database. It is easy to import data files into the software, 
and MMEX supports four import formats as of December 2020. These four supported 
import formats are:

•	 QIF (Quicken Interchange Format)
•	 CSV (Comma-Separated Values) 
•	 XML (Extensible Markup Language) 
•	 WebApp 

MMEX allows you to export your existing database into five export formats as of De-
cember 2020. These five supported export formats are: 

•	 QIF (Quicken Interchange Format)
•	 CSV (Comma-Separated Values) 
•	 HTML (HyperText Markup Language  
•	 XML (Extensible Markup Language) 
•	 JSON (JavaScript Object Notation)

Importing a database 
You can import data into a new database to quickly start using MMEX. 
To import a database

1.	 Ensure that MMEX is closed. 
2.	 Launch MMEX and select Create a New Database. 
3.	 Name your new database and select Save.  

The New Database Wizard displays. 
4.	 Select Cancel.
5.	 Select a base currency and select Cancel to close the New Database Wizard. 
6.	 Select File > Import and select the required format.  
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The Import dialog displays.
7.	 Select Choose file and select a file to import into MMEX.
8.	 Configure the import options and select OK.

Exporting a database 
You can export your MMEX database to make your data portable. 
To export a database 

1.	 With your database opened in MMEX, select File > Export and select the re-
quired format.  
The Export dialog displays.

2.	 Select a location to export your database to and name your file.
3.	 Configure the export options and select Export.

About Reports
MMEX has an internal templating engine that allows you to create detailed and unique 
reports without external tools. With out internal templating engine, your reports can be 
completely customized and personalized with configurable SQL queries, LUA codes, 
and front-end scripts (HTML, CSS, and JavaScript). 

MMEX supports the creation of a variety of reports. Some reports require user input, 
and some are generated automatically by the software. These are the automatically 
generated report types:

•	 Cash Flow 
•	 Categories
•	 Forecast Report 
•	 Income vs Expenses
•	 My Usage 
•	 Payees 
•	 Summary of Accounts 
•	 Budget Performance 
•	 Budget Category Summary
•	 Stocks Report

You can view the automatically generated reports in MMEX, or manually create a report 
from scratch and configure its appearance according to your preferences. This section 
teaches you how to do that.

Viewing automatically generated reports 
You can view the automatically generated reports from the Navigation Pane. Refer to 
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“About Reports” on page 22 for a list of them. 
To view an automatically generated report

Under Reports in the Navigation Pane, select a report for viewing.  
The selected report displays in the Report view. 

Tip: Configure the settings with the toolbar across the top to filter accounts, peri-
ods, or show and hide charts. 

Creating a report manually
You can manually create a customized report with the General Reports Manager. 
To create a report manually 

1.	 From the Top Menu bar, select General Report Manager. 
The General Reports Manager dialog displays. The navigation pane within the 
General Reports Manager is blank by default.

2.	 From the navigation pane within the General Reports Manager, right-click on 
Reports and select New Empty Report. 

3.	 Enter a name for the new Report Group and select OK.
4.	 Enter a name for the new report and select OK. 

A new report now displays in the navigation pane, and five new tabs display 
(Output, SQL, Lua, Template, and Description). 

5.	 Navigate to the SQL tab, ensure that the script ends with a semicolon (“;”) and 
select Test. 

6.	 Select Run to generate the report  
Your new report is now generated and can be accessed in the Output tab and in 
the Report view.
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Importing a report 
You can download an existing report created by users and developers here on GitHub 
and import it into MMEX. 

Warning: Be wary of malicious files from the internet. Always scan for viruses 
and ensure the files are clean before downloading them onto your computer.

To import a report  
1.	 Optional: Download a report from here on GitHub onto your computer. 
2.	 From the Top Menu bar, select General Report Manager.
3.	 Select Import.
4.	 Locate and select a report as required and select Open.  

Your new report is now imported and can be accessed in the Report view. 

About report outputs
Many MMEX users create report templates and upload them onto our GitHub communi-
ty to share with other users. If you want to contribute to the community, or just create an 
output for personal usage, you can export a report to a ZIP file. 

Exporting a report 
You can export a report into a ZIP file with the General Reports Manager dialog.
To export a report 

1.	 From the Top Menu bar, select General Report Manager.
2.	 From the navigation pane within the General Report Manager, select a report to 

export. 
3.	 Select Export. 
4.	 Select a location to store the output and select Save. 

Printing a report
You can print a report for review with MMEX.

1.	 From the Navigation Pane, select a report. 
2.	 From the Top Menu bar, select Print current view. 

The Print Review window displays. 
3.	 Configure the printing options and select Print Document.  

https://github.com/moneymanagerex/general-reports/releases
https://github.com/moneymanagerex/general-reports/releases
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What is Personal Finance?
The term “personal finance” refers to the management of finance, which covers many 
processes like budgeting, estate planning, record keeping, and managing, saving, and 
investing your money. We often use the term to refer to the entire industry which pro-
vides financial services and advice to people about financial and investment manage-
ment.

To the MMEX team, helping users manage their personal finance is about helping the 
users reach their financial goals, like planning for retirement, saving for a house, or 
paying for college. 

Read more about what personal finance is. 

Five areas of personal financial planning 
According the Practical Financial Tips, personal financial planning can be broken down 
to five phases:

•	 assessing finance 
•	 setting financial goals 
•	 creating a financial plan
•	 executing the financial plan
•	 monitoring and reassessing the financial plan 

Assessing finance

You can assess your current financial condition by analysing your financial balance 
sheets and income statements. Review data on the values of your assets like bank sav-
ings, automobiles, and investments, and liabilities like loans, debt, and mortgages. You 
can use MMEX to track and analyze your finance like incomes, expenses, investments, 
and assets. 

Setting financial goals

There are three categories of financial goals: short, medium, and long-term goals. Set-

Appendix: Personal Finance 
Concepts

https://www.investopedia.com/terms/p/personalfinance.asp
https://www.practicalfinancialtips.com/
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ting realistic and achievable financial goals help you set a direction when planning your 
finance.

Creating a financial plan

You must have a financial plan to reach your financial goals. Create a detailed finan-
cial plan with steps listed for achieving your goals. Some examples of these steps may 
include investment, reducing expenses from dinning out, or getting a side job. 

Executing the financial plan

Once you have a plan, you must start taking actions to achieve your goals. You can 
follow your financial plan at your own pace. The important thing is that you actually start 
executing it. 

Monitoring and reassessment of financial plan

Your financial plan might change as time progress. You might develop different needs 
and wants, like starting a family or attending post-graduate school. So, you should al-
ways monitor and readjust your financial goals from time to time. 

Read more about the five personal financial planning phases.

What is Financial Literacy?
MMEX was first developed to help people with little knowledge of financial planning and 
management to start managing their personal finances quickly and effortlessly. Financial 
literacy is important and is becoming increasingly more so today. 

Investopedia is a website that aims to simplify complex financial information and deci-
sions to help readers manage their finance. According to Investopedia, financial literacy 
refers to the ability to understand and effectively use different financial skills and con-
cept to manage personal finance, budget, and invest. People who are financially literate 
are less vulnerable to monetary loss from financial frauds. Building a strong foundation 
of financial literacy also helps you reach certain life goals surrounding finances. 

Read more about what financial literacy is.

The importance of financial literacy
Building a strong foundation of financial literacy is more important today than ever be-
cause many countries are moving away from using cash as their main payment method. 
It is also easier for someone to pile up debt and exceed the limit of your credit. If you do 
not have proper knowledge of how to manage your personal finance, you can get into 
trouble very easily. 

Six financial literacy principles 
The Royal Bank of Canada Wealth Management Services published an article on the 

http://www.practicalfinancialtips.com/personal-finance/what-is-personal-finance/
https://www.investopedia.com/
https://www.investopedia.com/terms/f/financial-literacy.asp
https://www.rbcwealthmanagement.com/ca/en/
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six financial literacy principles to help young people build great financial management 
skills. These six principles are:

•	 budgeting 
•	 understanding taxes
•	 borrowing 
•	 planning before investing 
•	 investing 
•	 preparing your estate

Budgeting 
There are four main uses for money:

•	 spending
•	 investing 
•	 saving 
•	 giving away

Creating a budget can help you find a balance among these four categories, and you 
should prioritize “saving”, and plan for expenses only after factoring savings into your 
budget plan. Consider setting aside an amount of your savings regularly to deposit into 
a savings plan.

Understanding taxes
There are four main sources of income: 

•	 employment 
•	 investments 
•	 inheritance
•	 unexpected (like a lottery win)

These sources may be taxed in different ways and at different levels, depending in the 
country you are based or are generating income in. You should consider tax when man-
aging your finance because failing to do so might lead to negative consequences. We 
recommend that you consult with a qualified tax advisor to make sure you are appropri-
ately accounting your circumstances and needs.

Borrowing
Credit refers to a form of borrowing that allows you to get something with the promise 
of repaying it in the future. When you borrow money, you share some information with 
a credit bureau, like if you have missed payments or how much outstanding debt you 
have. These information are used by the credit bureau to calculate a “credit score”, 
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which is a number that indicates if you can pay your bills on time. To maintain a good 
credit score, make sure you pay your bills on time.

There are three main types of credit: credit cards, personal or term loans, and line of 
credit. Be wary when you borrow money because all forms of credit come with a cost as 
most lenders charge you for borrowing their money. 

Planning before investing 
Identify your financial goals to help decide what types of investments and planning ap-
proaches may help you save for your needs in the more effective way. Try to figure out 
your needs and wants to set realistic goals you can achieve. 

Investing 
There are two main types of investment accounts: Registered and Non-Registered, and 
they both have different implications for investors. 

Registered accounts are accounts that are you register with the government for income 
tax purposes and tax-deferral opportunities.

Non-registered accounts are accounts that you do not register with the federal govern-
ment. They do not have limits, and you must include earn income as taxable income 
every year. 

When you invest, there is a notion of risk and return. A higher potential return means 
there are more risks. For most investments, there is no guarantee that you would re-
ceive any return. 

Preparing your estate
Planning your estate means creating a detailed plan with tasks and decisions for how 
people would manage all your properties during your lifetime and after your death. 
When you have an estate plan and a Will, you can make sure that people would carry 
out your wishes and manage your assets accordingly.  

Read more about these six financial literacy principles. 
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